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Introduction
 The Laerdal® Advanced Video System (AVS) is a video recording system 
which can be used with Laerdal’s Patient Simulators SimMan® and 
SimBaby™.  The AVS allows recording, playback, distribution and viewing / 
reviewing of simulation video and audio footage.  

The AVS integrates seamlessly with the SimMan and SimBaby systems which 
record data from the simulated Patient Monitor and the scenario log. The 
combination of the video and scenario data can be presented to the user 
in the Laerdal Debrief Viewer, which is part of the SimMan and SimBaby 
systems. 

The AVS has two separate confi gurable software modules that gives 
teaching professionals enhanced fl exibility and a cost effective solution to 
documenting clinical and non-clinical simulation training.  

The fi rst module of the AVS is the Laerdal Video Server.  The Video 
Server computer is the main hub in the system. It compresses the input 
from up to four video cameras and one audio channel into a more effi cient 
transportable signal.  This video signal is distributed on the local network.

The second module of the AVS is the Laerdal Video Client software 
program. When installed on any computer on the network, it will allow 
real-time access and viewing to the simulation video footage and data from 
the Patient Monitor.  

Laerdal Recommends
When installing Laerdal software to your network, it is recommended 
that this service is conducted by an Information Technology 
Professional who has administrator rights. Read all instructions and 
Cautions and Warnings prior to setup and operation of the 
Laerdal Advanced Video System.

 

Cautions and Warnings
•  By using this product, Laerdal Medical does not condone the use of this 

system for violating any government, state or local laws or personal 
rights.  

• This product contains software that may be installed to other computer 
systems that may allow remote visual and audio monitoring allowing 
access to private networks and the recording of unannounced 
conversations may be a violation of personal rights. It is recommended 
that individuals in the areas of recording equipment be made aware of 
the installed equipment and to the fact that their conversations and 
activities could be viewed and recorded without notice. 

• It is not advised to use this system as a means of physical security for the 
protection of public or private property. 

• Laerdal Medical will not be responsible for loss or stolen property due 
to the use or failure of operation of this equipment.

• Read, understand and follow all equipment instructions, safety warnings 
and guidelines before operating the Laerdal AVS and all associated 
equipment. 

• Do not use cables or connectors with bent pins or visible damage.

Warranty
Please refer to the enclosed printed Laerdal Global Warranty or www.
laerdal.com for terms and conditions.

Items Included in Advanced Video System (AVS)
(1) PC Video Server with installed software
(1) Mouse
(1) Keyboard
(1) DVI to SVGA Adapter
(1) Video card to 8 BNC connectors (4 Audio + 4 Video)
(5) BNC to RCA Adaptors
(1) Flat Panel LCD Monitor
(1) Installation Video Client Software 
(1) Directions for Use

Audio / Video System Requirements (not supplied):
•  1-4 video cameras with composite video output
• Microphones
• Audio mixer (provides “line out” signal)
• Network cables

Subjects covered in this document:
Video Server
• Video Server Setup and Confi guration
• Video Server Operation
• Audio Connection
• Monitor Connection
• Camera Connection
• Cable Connection

Video Client
• System Requirements
• Cable Connections
• Software Installation
• Video Client Operation

SimMan® / SimBaby™   
• Presets and confi gurations

 ENGLISH
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Unpack
The Laerdal® AVS is packaged to ensure that no damage is incurred during 
transportation to the end user. The end user should inspect the contents of 
all boxes for damage and report any damage to Laerdal as soon as possible.  
It is recommended that original packaging is not disposed of during the 
warranty period. Reusing the original packaging will help prevent damage 
that could occur in the event of equipment defect or recall to Laerdal 
Technical Support. 

Video Server Setup and Confi guration
1. Unpack and make available all cables and adapters. (Photo 1)

Photo 1

2. Power is applied to the Video Server via a standard PC power cable. 
Connect the power cable to the Video Server. (Photo 2)

Photo 2

3. Connect the monitor and Audio/Video adapter or cables to the back of 
the Video Server. (Photo 3)

Photo 3

4. The Monitor Adapter Cable has a DVI connector on one end and a 
(SVGA) high density, fi fteen pin connector on the other end.  The DVI 
connector end plugs into the monitor DVI port on the video card. The 
other end is used for connecting the SVGA monitor 1.  (Photo 4)

  Photo 4

5. The Audio and Video Adapter Cable has eight wires with BNC 
connectors on one end and a dual roll fi fteen pin connector on the other 
end. (Photo 5)

  Photo 5

6. The video connectors are easily identifi ed by the marking on the 
connectors VID1, VID2, VID3 and VID4.  Up to four cameras may be 
connected to this cable. (Photo 6)
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  Photo 6

7. The audio connectors are identifi ed by the marking AID1, AID2, AID3 
and AID4 on the connectors.  Only AID1 can be used by the Video 
Server.  The input to AID1 cannot support multiple microphones. This 
can be accomplished by using an audio mixer with a preamplifi er.  An 
audio mixer will enable the mixed microphones to be combined as one 
audio signal. These mixed signals are inputted into the AVS using the AID1 
connector. The audio mixer will also allow the increasing or decreasing 
of the microphone(s) gain to an acceptable level. When a microphone is 
used without an audio mixer, the input gain will be too low for the AVS 
and no audio will be detectable. (Photo 7)

  Photo 7
 
8. The AVS comes with fi ve BNC to RCA adapters. They may be used with 

either or both the audio or video connections. Your system may have the 
proper BNC mate connection and not require using the BNC to RCA 
adapters. (Photo 8)

  Photo 8

9. The USB Mouse and USB Keyboard can be connected to any one of the 
many USB connections. The network cable plugs directly to the network 
connection on the back of the Video Server. (Photo 9)

  
         Photo 9

10. Monitoring the audio can be done by connecting speakers to the 
speaker receptacle on the back of the Video Server.  Speakers are not 
provided. (Photo 10)

Photo 10

Video Server Software Setup and Confi guration
The Video Server software is pre-installed; however, in the event the server 
suffers a critical failure, contact Laerdal Technical Support and arrangements 
will be made to reinstall your video server software. 

1. Select the Icon marked “Laerdal Video Server.”  This will start the 
program and open the main screen. (Photo 11)

  Photo 11
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The monitor screen will indicate that the DSP Server is starting.  
(Photo 12)

Photo 12

2. The start screen will show up to four camera views if they are 
connected. (Photo 13)

Photo 13

3. The fi le menu has four options:
• Open a saved fi le confi guration fi le
• Save the current confi guration as default
• Save As a new confi guration fi le name and at a user specifi c folder  
   location
• Exit to end the program (Photo 14)

  Photo 14

4. The help menu has two options:
• Show Help provides any program help available to the user.
• About will give information about the software name and version. 
  (Photo 15)

  Photo 15

5. The Settings menu has three options
• Video Setup  
• Server Setup
• View Statistics    (Photo 16) 

  Photo 16

• Video Setup  
 o Quality Presets controls the quality of the video stream as it is  
  played to the SimMan, SimBaby and the Video Client.  
 o “Functions,” when selected, will start the streaming video at the  
  onset of the Video Server program.
 o Bit Rate Type default is VBR.
 o Encoder Resolution default is CIF.  (Photo 17)

  Photo 17
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• Server Setup
 o The Video Server Name is a generic name you can assign to the  
  Video Server.  It is not to be confused with your computer name.  
  When selecting the Video Recording Confi guration option of   
  your simulation software, this will be the name of the server that  
  is to be entered.
 o Server Port is auto assigned, but may be manually assigned. 
 o Client Port is auto assigned, but may be manually. (Photo 18)

  Photo 18

6. Select the “Start Video Stream” in order to send the camera video and 
audio to the SimMan, SimBaby and Video Client. The assigned Server 
Name displayed from the “Server Options.”  The Channel Color Controls 
adjustments can be adjusted for each camera view. First select camera. 
Next, adjust the Channel Color Controls. Then, select the next camera 
and repeat the process. Your confi guration will be  saved when the “Save” 
is selected under the File menu. (Photo 19)

  Photo 19

7. After the “Start Video Stream” is selected, the button name will change 
to “Stop Server.”  “Stop Server” must be shown in the frame in order for 
the Video Client and the simulators to be able to record from the server. 
Once the Video Stream is captured and the recording is in progress 
at the simulator, it will communicate back to the Video Server and the 
“Stop Server” will be grayed out and will no longer be a selectable 
option. This is to prevent any accidental stopping of the video stream 
during a recording session. When the recording session is completed, 
the simulation program will ask if the operator would like to save the 
recorded data to a fi le. Once the data is saved or discarded by the 
operator, the exiting of the simulation program will make the Video 
Server available to the network. The “Stop Server” will then be returned 
to a selectable option and will no longer be grayed out.

Laerdal® Video Client Software Setup and 
Confi guration
The Laerdal Video Client Software is installed from the installation disk 
that comes with your system.  To install the Video Client software, fi rst 
insert the installation disk into your CD/DVD drive. Close the drive door 
and an auto install sequence will open to a menu of the software that is 
available for installation. Select to install by clicking with your left mouse 
key only once and your software will start the installation process. After the 
installation is completed, there are some confi gurations that must be made 
to ensure you have the best video solutions available. Following the setup 
and confi guration instructions will help to gain a better understanding of 
the Video Client operation.

Video Client System Requirements
1. Computer Minimum Requirements

o Type:  Dell Latitude 
o Processor: Pentium M, min 1.8GHz
o HDD: 60 GB min.
o RAM:  512 MB min.
o System: Microsoft Windows XP
o Screen: Dual screen with min 1280 x 1024
o Mouse: 2 button scroll wheel mouse
o Other: CD-RW or DVD-RW
   RS-232 (serial port)
   Microphone input
   Headphone output
   2-4 USB ports
   Internal Bluetooth
   Built-in Ethernet LAN

Note:  The computer requirements are recommended to support the 
recording and transferring large amounts of data to a data disk for media 
storage. Failure to have a quality media storage device will limit the amount 
of training and recording time available to the end user.

Cable connections
1. Connect the network cable to the network receptacle on the computer 

and to the network access point. This connection is not necessary to 
view a saved fi le on a CD/DVD.

2. Software Installation
 Insert CD and follow the software installation process as supplied on the 

installation disk.

Video Client Software Setup and Confi guration
1. Select the Icon marked as Laerdal Video Client. This will start the 

program and open the main screen. (Photo 20)

  Photo 20

2.The option for the “Room Selection” will be available. If more settings 
or confi gurations are needed, then select “OK” and move to the “File 
Menu.” If no changes are needed, then select “Apply.” (Photo 21)
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  Photo 21

3. File menu has one entry “Save recorded video as…” 
o The selection cannot be listed until a recording has been created using 

the Video Client “Record” feature. If you have just saved a recording, 
you will be able to save the same views a second time as a new name.     
(Photo 22)

  Photo 22

4. Settings Menu has two selections, “Confi guration…” and “Connection 
Setup.”  (Photo 23)

  Photo 23

o Confi guration is to setup a specifi c saved fi le storage location.  All the 
video recorded from the Video Client recording session will default to be 
saved into the location assigned here. (Photo 24)

  Photo 24

o Connection Setup menu is the main screen enabling the user to select 
Rooms and Server available for use. The server is located 

   by manual or automatic IP selection.  (Photo 25)

Photo 25

o To create a new room, fi rst select the “Room Name” box in the “Room 
Information” section of your display. Type in the new room name in place 
of the existing room name. Then select the “Create New Room” button. 
The just made new room is inserted into the “Available Rooms” window. 
Select the room name just inserted into the “Available Rooms” window.

   Next, defi ne how the new room will be used. If there are more than one 
“Available Server,” select the server intended for use. The monitor must 
be selected at this time also. This is accessed from the available monitor 
list. Next, select the available cameras by selecting the appropriate 
camera numbers. Then select “Apply.”  The room will be saved and will be 
available in the confi guration created until deleted or new changes to the 
defi ned confi guration.

o After the “Find Sources” is selected, all available monitors and available 
   servers will be displayed in their appropriate window.

o Selecting the appropriate server will enable the view of the video 
stream being sent by the server. The patient monitor video is sent by 
the SimMan® or SimBaby™ computer that the simulation is running 
from. There may be a time during the training session that one or more 
cameras may not be needed. When this happens you can select between 
one and four camera views. The audio will be available to record 
from only “camera 1.” 

o The Help Menu has two drop down selections. “Show Help” and 
   “About.” (Photo 26)

  Photo 26

o Show Help selection has numerous topics of information and features.  
By selecting a help topic, any information available on the topic will be 

   displayed. This section is for general guidance. (Photo 27)
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  Photo 27

o The “About” selection shows information about the software name, 
   version, copyright and owner of the copyright. (Photo 28)

  Photo 28

5. Layout and Sound
o The Video Client sound volume is on the slide bar located at the 
   bottom left of the screen. Sliding to the right increases output and to 
   the left decreases output. (Photo 29)

  Photo 29

o Next to the sound slide bar are the display layout settings. There are
   four predefi ned layouts for the display screen.  (Photo 30)

  Photo 30

o The fi rst view will put a small screen into a large screen. The small screen 
can be enlarged by holding the left mouse button and dragging it to the 
size you want. Double clicking the left mouse button will enlarge any 
selected display to full screen. Double clicking once more reduces back 
to previous setting. (Try it!)

o Another way to change from one view to another is to put the mouse 
over the screen to move. Then depress the left mouse button and hold. 
An icon of a small computer will appear on your screen while the mouse 
button is being depressed. Move the mouse to the screen area where 
the image is needed to be viewed. By releasing the mouse button, the 
icon of the computer will disappear and the screen will have been moved.   
(Photo 31)

Photo 31

o The second layout will display four equal sized screens. (Photo 32)

Photo 32
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o The third layout will display one large screen and three smaller screens 
   on the right side. (Photo 33)

Photo 33

o The fourth layout displays one large screen. (Photo 34) 

Photo 34

6. Display Screen
   Selecting the “Layout” screen to determine the desired view is the fi rst 

of many options for screen viewing. There are six possibilities for each 
of the panes displayed in the “Layout” screen. To view the display screen, 
right click the window and the six options will be displayed.
• Monitor displays the Patient Monitor sent from the simulation 
   software.
• Camera 1 - 4 displays the view from the selected camera. 
• Blank will leave no information on the screen and will not be recorded.
• Camera (-) indicates that any camera with (-) beside it, is not the 
   camera being viewed or selected. 
• Camera (pos1-4) indicates the camera number as it is available by the 
   order sent from the video server. 
• Blank indicates no monitoring is selected by the user. (Photo 35)

  Photo 35

6. Select Room
   This selection is used for one or multiple video servers and cameras. 

By assigning room numbers or room names, it is possible to switch 
between the various cameras connected to the various video servers. 
This is a good way to audit training or record meetings. If there is only 
one video server that has multiple cameras, it is possible to assign room 
numbers that select the best set of cameras to view while the training 
is conducted and be able to select the same view again at a later time. 
For example, Room 1 may use Camera 1 to view with. Room 2 may 
use Cameras 1, 2 and 4 to view with. Room 3 may use the monitor and 
cameras 1, 2, 3 and 4 to view with. If you are recording a meeting, then 
the room name can be changed to “Meeting Room” and use any camera 
needed to get the best possible view. (Photo 36)

  Photo 36

8. The “Start Recording” button will enable the recording feature. The 
default position is in the off position. This is indicated by the black square 
located to the left of the “Start” button. Once the recording is started; 
then the black box will change from a solid black to a blinking red. Once 
the recording is stopped, the option to save will be displayed. Choose a 
new fi le name and save the recording to the default directory.  Saving the 
video recording will be saved to the default assigned in the “Video Client 
Confi guration” by checking the “always save video in this folder” check 
box. Once selected, you will only have to name the recording session and 
save the Video and Monitor recordings. (Photo 37)

  Photo 37

9. Time
   The length of time of your recording is indicated by the clock counter to 

the right of the “Record” button. (Photo 38)

  Photo 38
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10. Exit
   Selecting the “Exit” will terminate the program and will give the option 

to save any unsaved recordings. (Photo 39)

  Photo 39

Network Information
1. The Laerdal AVS is intended to be used with a pre-existing network. It 

is recommended that a networking professional with full administrator 
rights incorporate this system into your network. The Video Server, 
SimMan and SimBaby all use shared fi les and the network must be setup 
to allow the video and audio fi les to be accessed by these programs. 
Laerdal has included the setup of these shared fi les with the installation 
of the Laerdal SimMan and SimBaby installation software. Your IT 
professionals are recommended to make any and all changes to these 
fi les and will require the “administrator rights” to be enabled to make 
changes.

2. Information for Information Technologies Professional. 
• When the installation software (SW) for the Video Server SW is run, a 
  local user called “SimVideo” will be created on the AVS computer.  This 
  user is restricted and has a password that is not possible to change. 
  This username (SimVideo) and password will be used by the SimMan/
  SimBaby SW to access the shared folder on the AVS computer, 
  where the temporary video fi les are located. 
• When installed, the SimMan/SimBaby SW, installation program will 
  add two keys into the registry, which stores the username and 
  password. However, the password for the default user (SimVideo) will 
  not be stored explicitly. The password will have the value “default” 
  which tells the SimBaby/SimMan program to use the SimVideo user      
  password. 
• If the user (or administrator) would like to create a new user on the 
  AVS computer and have the SimMan/SimBaby SW, use this account 
  instead - the user is free to make a new account on the AVS computer, 
  the only additional thing to do is to change the username and 
  password in registry in the SimMan/SimBaby PC. 
• Reinstall. If the SimMan SW or the SimBaby SW is reinstalled, the 
  corresponding user name and password in registry is reset to the 
  default values. 

• Location in registry:
 • SimMan:
  • My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Laerdal  
     Medical\SimMan\
• SimBaby:
  • My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Laerdal 
     Medical\SimBaby\
• Keys:
 • Password: DSPRAccess
 • Username: DSPRAccess
• Warning:
 • Changing values in registry is not for novices. We recommend   
  that only expert users change the values in registry. 
 • Changing the values in the registry should not be necessary   
     unless the system requires it due to special policies.

3. In the event there is no network at your facility, information is available 
at the Microsoft website. Searching for the information on how to setup 
a network using Microsoft Windows XPTM will revile information on 
equipment needed, installation requirements and setup instructions. If 
you are not familiar with sharing of fi les and folders, do the same type of 
search for information on network fi le sharing. 

4. If the computer is not connected to a network domain, the network 
can be set up as a workgroup. The “Manual Address” box must then be 
selected. Once a “Work Group” network is established, the “Manual 
Address” must be selected and all IP Addresses are manually assigned. 
When a router is used with a network, the IP Address will be assigned 
automatically.

5. Network servers with a domain will assign the IP Address automatically.    
6. It is not recommended to operate this system on a wireless network 

due to the large amount of bandwidth consumed. There could be a loss 
of video and audio data as the wireless system uses up the networking 
resources.

7. The Video Server must be sending the video stream in order for the 
Video Client, SimMan and SimBaby to record and playback properly.

Start Up and Stopping Procedures
These procedures must be followed in the same order of operation. All 
connections and presets must be completed prior to operating the Video 
Server and the Video Client. Any audio and video (cameras/audio mixers) 
equipment connected to the Video Server requiring power must be turned 
on and ready for operation prior to starting these procedures.

AVS Start Up:
Step 1 - Turn on AVS computer LCD display

Step 2 - Turn on Video Server Computer

Step 3 - Select the icon labeled “Laerdal Video Server” from AVS 
            computer desktop

Step 4 - Select “Start Video Stream” from the bottom left side of the   
            Laerdal Video Server display screen. 

SimMan/SimBaby
Follow instruction manual for operating the SimMan or SimBaby simulator 
provided with the desired simulator.

Step 1 - Turn on simulator equipment and start simulator software. 

Step 2 - Follow simulator instruction provided with each Simulator

Step 3 - Follow Simulator instructions for exiting Simulator at completion 
            of operation.

Starting Laerdal Video Client:
Step 1 - Turn on computer and monitor with the Video Client Software           
            installed.

Step 2 - Select the icon labeled “Laerdal Video Client”

Step 3 - Select “Room”

Step 4 - Select “Apply”

Step 5 - Select “OK”

Step 6 - Adjust “Sound” to desired level.

Step 7 - Select desired “View”

Step 8 - (optional) Select “Record” to start recording of information being 
             viewed.
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Exiting Laerdal Video Client:
Step 1 - (optional) Select “Stop” to end recording. If required, name and 
             save data to desired location.

Step 2 - Select “Exit” on bottom right of the “Laerdal Video Client” 
            display screen

AVS Stopping Procedure:
These procedures are to be followed if the simulator is no longer in 
operation and there is no need to allow access to the “Laerdal Video 
Server” or rooms being viewed by the “Laerdal Video Client.”

Step 1 - Select fi le from the upper right side of the “Laerdal Video Server” 
            Display.

Step 2 - Select “Exit” from the “File” drop down menu.

Step 3 - Turn off equipment as needed.

Simulations Software
1. The use of this software set is in conjunction with Laerdal patient 

simulators.  Without the simulations software presets set, there can 
be no recording by the debriefi ng software or the Video Client. The 
following are descriptions of typical settings that must be made.
o Under the Edit screen there is a drop down menu for the “Video 
   Recording Confi guration.” (Photo 40)  

  Photo 40
 

o The Video Recording Confi guration has the ability to use no camera, 
   a WEB Cam, or the Video Server. In this confi guration, we use the “Use 
   video server” selection.  A note of caution, this selection may give a 
   simulation video error if the Video Server is not sending out the video 
   stream. (Phot0 41)

  Photo 41

o The Video Server Recording fi eld is the location where the name that 
   has been assigned to the Video Server is entered. The default name 
   “Skagerak” will work just fi ne unless there is more than one video 
   server. Remember this is not the PC’s name.  You must also select 
   which cameras you would like to enable from the Video server to  
   record to the “Laerdal Debrief Viewer.” (Photo 42) 

  Photo 42

o The Patient monitor recording is enabled by checking the empty box. 
   If there is a need to record the patient monitor to the Laerdal 
   “Debrief  Viewer” or the Video Client, then this block must be selected. 
   This is also where you decide the quality of the recording.  (Photo 43)

  Photo 43

o The Recording time is used to help you manage your debriefi ng time 
   limit. This will help you manage the amount of data that may be needed 
   to be saved to a CD/DVD. In high or medium resolution, you could 
   exceed the recording limit of a standard CD.  (Photo 44)

  Photo 44

o The Monitor source identifi cation for Video Client is to enable the 
   simulator PC to be identifi ed by the Video Client software. This will 
   make the port information and simulator PC accessible from the Video 
   Client.  The confi guration “OK” and “Cancel” will keep your changes 
   and exit the menu or exit without saving any changes. (Photo 45)

  Photo 45

Maintenance 
Cleaning
1. Cleaning electrical equipment and their assemblies must be done in 

accordance to the proper equipment manual.
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Advanced Video System (AVS) trouble shooting guide

I received an error message
The following describes the different error messages that the user might 
encounter during the use of the Advanced Video System. 

SimMan®/SimBaby™ application
1. Copy fi le problem
 Error message:

 
Cause:
a. The connection to the server was for some reason lost during   
   the simulation. 
Fix: Check your network connections. 

b. Access rights to the shared folder “tempDSPRFiles” on    
    VideoServer have been lost. 
Fix: Check the access rights to the AVS PC. It should have user account 
called “SimVideo.” This user gives the SimMan/SimBaby SW access to 
the shared folder. For more information on this, please read the DFU 
(Directions For Use).

2. Server connection problem
   Error message:

Cause:
a. Wrong Video Server name 
Fix: From the “Edit” menu in the SimMan/SimBaby software, open 
the “Video recording confi guration” dialog. Compare the “Video 
server name” with the “Server name” in the Video Server application. 
The server name is found in the bottom left corner of the main 
window of the Video Server application. Make sure that the names 
match.

b. Video Server is not running
Fix: Make sure that the button in the lower left corner of video server 
reads: “Stop Server”. If it reads: “Start Video Stream”, click the button.

3. Server connection problem
   Error Message:

Cause:
a. Video Server is not running
Fix: Make sure the Video Server application is running. If not – start 
it by double clicking the Video Server icon on the desktop or from 
the start menu.

b. The video stream has not been started
Fix: Make sure that the button in the lower left corner of video server 
reads: “Stop Server.” If it reads: “Start Video Stream,” click the button. 

Hint: To automatically start Video Streaming on Video Server startup, select the 
“Start Video Streaming on application startup” in the “Video options” dialog.

4. Video Server is busy
   Error Message:

Cause:
This error can have two different causes
a. Video Server is already recording
Fix: The server application is already recording for another SimMan/
SimBaby application. Check with all SimMan®/SimBaby™ PC’s on the 
network to fi nd and stop the SimMan® application which is recording.

b. The Video Server application may have been turned off
Fix: Check that the video server is running and the button in the lower 
left corner of video server reads: “Stop Server.” If it reads: “Start Video 
Stream,” click the button.

Video Client
1. Server is not responding
   Error Message:

Cause: 
a. Wrong Video Server name / IP address
Fix: Open the “Connection Setup” dialog under “Settings.” Check that 
the correct Video Server is selected.

b. Video Server is not running
Fix: Make sure the Video Server application is running. If not – start it by 
double clicking the Video Server icon. 

c. The video stream has not been started
Fix: Make sure the button in the lower left corner of video server reads: 
“Stop Server.” If it reads: “Start Video Stream,” click the button. 

Hint: To automatically start Video Streaming on Video Server startup, select  the 
“Start Video Streaming on application startup” in the “Video options” dialog.
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2. Server connection problem
   Error Message:

Cause:
a. Video Server is not running
Fix: Make sure the Video Server application is running. If not – start it by 
double clicking the Video Server icon. 

b. The video stream has not been started
Fix: Make sure the button in the lower left corner of video server reads: 
“Stop Server.” If it reads: “Start Video Stream,” click the button. 

Hint: To automatically start Video Streaming on Video Server startup, select the 
“Start Video Streaming on application startup” in the “Video options” dialog.

Video Server
1. Card initialization problem
   Error Message:

Cause: 
a. The Video Server fails to initialize the video recording card
Fix: Make sure the video card is properly installed. 

b. The video compression card or the AVS PC is defective
Fix: The PC should be returned to Technical Support for further 
investigation. Go to the end of this trouble shooting guide for more 
details.

2. Start server problem
   Error Message:

Cause: 
a. The Video Server fails to start properly. This is caused by an error in 
the video card initialization, which is most often caused by an installation 
error. 
Fix: The Video Server must be reinstalled. 

b. The video compression card or the AVS PC is defective 
Fix: The PC should be returned to Technical Support for further        
investigation. Go to the end of this trouble shooting guide for more       
details.

I can’t see the video
Debrief Viewer
1. Error: The Debrief Viewer doesn’t display any video.

Cause: 
a. The video recording is not turned on. (There shall be a red “Stop Rec” 
and a red dot in the bottom left corner of the SimMan®/SimBaby™ 
application if it is recording:)

Fix: From the “Edit” menu in the SimMan/SimBaby software, open       
the “Video recording confi guration” dialog. Make sure that “Use 
video server” is selected. In addition, make sure that the appropriate 
cameras have been selected under “Video server recording.”

b. The right video is not selected in debrief viewer.
Fix: Try to change between different views by using the buttons on the 
bottom right of the Debrief  Viewer. Try to right click any of the video 
areas and change between different video sources.

c. There is a problem with the connection to the video server. 
Fix: You should have received an error message. Refer to the appropriate 
section. If this is not the case, double check your network connections. 
Check that the Video Server is turned on, displays the camera views and 
is streaming video. To verify that it is streaming video, make sure that the 
button in the lower left corner of video server reads: “Stop Server.” If it 
reads: “Start Video Stream,” click the button.

Video Client  
1. Error: The Video Client doesn’t display any video.

Cause: 
a. The video server is not selected.
Fix: From the “Settings” menu in the Video Client, open the “Connection 
Setup” dialog. Make sure that correct server is selected under  “Available 
Server.” In addition, make sure that the appropriate cameras have been 
selected.

b. The right video is not selected in debrief viewer.
Fix: Try to change between different views by using the buttons on the 
bottom left of the Video Client. In addition, try to right click any of the 
video areas and change between different video sources.

c. There is a problem with the connection to the video server. 
Fix: You should have received an error message. Refer to the appropriate 
section. If this is not the case, double check your network connections. 
Check that the Video Server is turned on and is streaming video. To 
verify that it is streaming video, make sure that the button in the lower 
left corner of video server reads: “Stop Server.” If it reads: “Start Video 
Stream,” click the button.

Video Server
1. Error: The Video Server doesn’t display any video.

Cause: 
a. The cameras are not connected.
Fix: Check that the cameras are connected to the correct input cable on 
the Video Server. The video cable should be connect to any of the cables 
that are marked “Vid 1”, “Vid 2”, “Vid 3” or “Vid 4”.

b. The cameras don’t have power.
Fix: Check that the cameras have power connected.
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c. The camera is broken.
Fix: Test the camera by connecting it the the AV input on a TV, or try 
another camera.

d. The video card is not properly installed. 
Fix: An error message should have popped up. If it does, refer to the 
appropriate section for error messages. If it doesn’t, there is a problem 
with the card or the installation of it. 

e. The video compression card or the AVS PC is defective.
Fix: The PC should be returned to Technical Support for further 
investigation. Go to the end of this trouble shooting guide for more 
details.

I can’t see the patient monitor
Debrief  Viewer
1. Error: The Debrief  Viewer doesn’t display the patient monitor.

Cause: 
a. The patient monitor recording is not enabled.
Fix: From the “Edit” menu in the SimMan®/SimBaby™ software, open the 
“Video recording confi guration” dialog. Make sure that “Enable monitor 
recording” is selected.

b. The patient monitor is not selected in Debrief  Viewer.
Fix: Try to right click any of the video areas and select “Monitor.” 

Video Client
2. Error: The Video Client doesn’t display the patient monitor

Cause: 
a. The patient monitor recording is not enabled.
Fix: From the “Edit” menu in the SimMan/SimBaby software, open 
the “Video recording confi guration” dialog. Make sure that “Enable       
monitor recording” is selected.

b. The patient monitor is not selected in Debrief  Viewer.
Fix: Try to right click any of the video areas and select “Monitor.” 

I can’t hear the sound or the audio quality is poor
Debrief  Viewer
1. Error: There is no sound played in the Debrief  Viewer or the quality is 

poor.
Cause:
a. The audio signal is connected to the wrong audio plug.
Fix: Connect the audio signal to the plug marked “Aid 1” on the back of 
the AVS PC.

b. There is insuffi cient audio input to the card
Fix: Use the Video Client while fi xing this: Start the Video Client and 
connect it to the same Video Server as the SimMan/SimBaby application. 
Test the sound from the Video Client and use the trouble shooting in the 
next section.

c. The sound is turned off in the Debrief  Viewer.
Fix: Adjust the sound with the sound control at the bottom of the 
Debrief Viewer.

d.The speakers are turned off or the output volume is too low.
Fix: Test that your speakers are working and try to adjust the output 
volume.

Video Client
1. Error: There is no sound played in the Video Client or the quality is poor.

Cause:
a. There is insuffi cient audio input to the card. This is the most important 
part for the sound quality/volume.
Fix: 
 i.  Check that the cabling is correct. 
 ii.  Increase the volume of the audio input.
 iii. Test that the audio input is OK.

b. The sound is turned off or is too low in the Video Client.
Fix: Turn up the audio volume control at the bottom of the Video Client. 
c. The speakers are turned off or the output volume is too low.
Fix: Test that your speakers are working and try to adjust the output 
volume. If the sound is still of poor quality or too low, repeat the 
adjustment of the input volume (a), followed by adjustment of output 
volume (b and c).

d. The video compression card or the AVS PC is defect. 
Fix: The PC should be returned to Technical Support for further 
investigation, go to the end of this trouble shooting guide for more 
details.

The video has poor quality
Debrief  Viewer
1. Error: The video quality in the Debrief Viewer is of poor quality.

Cause:
a. The Debrief Viewer is not set up to run with high image quality   
to save processing power.
Fix: In the Options menu, make sure that “Image quality high” is ticked.

b. The Video Server is not set up to use the highest quality.
Fix: In the Video Server application, press the “Stop Server” application in 
the lower left corner. If the button reads “Start Video Stream”, just leave 
it like this. Select “Video Setup” in the “Options” menu and press the 
“High Quality” button for quality presets. Press OK to use this setting 
and close the dialog. Start the Video Stream by pressing the “Start Video 
Stream” button in the lower left corner. 

c. The video compression card or the AVS PC is defect. 
Fix: The PC should be returned to Technical Support for further 
investigation, go to the end of this trouble shooting guide for more 
details.

Video Client
1. Error: The video quality in the Video Quality is of poor quality.

Cause:
a. The Video Server is not set up to use the highest quality.
Fix: In the Video Server application, press the “Stop Server” application in 
the lower left corner. If the button reads “Start Video Stream”, just leave 
it like this. Select “Video Setup” in the “Options” menu and press the 
“High Quality” button for quality presets. Press OK to use this setting 
and close the dialog. Start the Video Stream by pressing the “Start Video 
Stream” button in the lower left corner.

The AVS PC is not working and has been returned to Technical 
Support
1. Verify that there is a problem

a.Connect audio and video signals and test:
 i.  Does the Video Server display video? If No, go to 2.
 ii. Can you start the Video Stream? 

  1. No? Try the trouble shooting above and go to 2 if you can’t   
 resolve the problem.
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 iii. Can you receive the Video Stream with Video Client?
  1. No? Try the trouble shooting above and go to 2 if you can’t   

 resolve the problem.

2. Isolate the problem
 You will need a local validated AVS system to isolate the problem.

a.Take the customer’s video compression card out of the customer’s AVS 
PC and replace the video compression card in the local validated AVS 
system. 
 i. Use the supplier’s sample server software (NetServerDemo.exe1).  
 Does the local AVS system still work? 
  1. Yes? 
     a. Does the card work with the Video Server and the Video   
     Client SW? 
        i. Yes? There is a problem with the customer’s AVS PC’s   
        hardware or software. 
  Fix: Try to reinstall the Video Server SW on the customer’s AVS  
  PC. 
      ii. No? If the customer’s system still doesn’t work after the 
      reinstall, there is probably an error with the customer’s AVS  
      PC’s hardware.
  2. No? There is a problem with the customer’s video   
    compression card or cable. Try with a working cable, if this 
    doesn’t help there is a problem with the video card. Contact the
    supplier.

Technical Data
General
Operating Temperature

0°C - 40°C at 90% relative humidity, non-condensing
Storage Temperature

-15°C - 50°C at 90% relative humidity, non-condensing

Standards/Approvals 
The product, when carrying the CE-mark, is in compliance with essential CE 
requirements and other relevant provisions of council directive 1999/5/EC.

EMC – Immunity against – and radiation of electromagnetic fi elds
Compliance is claimed for the essential requirements in council directive 
1999/5/EC regarding the harmonization of the member states’ regulations 
regarding Radio and Telecommunication Terminal Equipment.
Conformity is based on the following technical standards:
EN 301 489-1 v1.4.1:2002
EN 301 489-3 v1.4.1:2002
EN 300 220-1 v1.3.1:2000
EN 300 220-3 v1.1.1:2000
FCC CFR 47 part 15

SD – Immunity against electrostatic discharges
Compliance is claimed for the essential requirements in council directive 
1999/5/EC regarding the harmonization of the member states’ regulations 
regarding Radio and Telecommunication Terminal Equipment.

Conformity is based on the following technical standards:
EN 301 489-1 v1.4.1:2002
EN 301 489-3 v1.4.1:2002
EN 300 220-1 v1.3.1:2000
EN 300 220-3 v1.1.1:2000

This product is in compliance with the
essential requirements of Council Directive
89 / 336 / EEC; EMC Directive.
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